
Congratulations on choosing the 3Com OfficeConnect ISDN LAN Modem! For the most common network application, 
creating a LAN with shared Internet access, the ISDN LAN Modem setup is a simple, two-step process:
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This 

 

Getting Started Guide

 

 provides instructions for installing and configuring the ISDN LAN Modem based on the most 
common configuration — shared Internet access. For advanced configurations, the 

 

OfficeConnect ISDN LAN Modem User 
Guide

 

 is available in PDF and HTML formats on the 

 

OfficeConnect ISDN LAN Modem Companion Programs

 

 CD-ROM. The 
flow chart below will help direct you to the proper documentation source and location for your network scenario.
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To complete your setup and establish an Internet connection for the first time, you must have the following:

 

■

 

ISDN Service 

 

already installed at your location, with an available ISDN RJ-11 outlet.

 

If you have not yet ordered ISDN service, call (800) 343-3266 to have 3Com order your line for you free of charge.

 

■

 

An Internet Service Provider (ISP) Account.

 

■

 

A Workstation

 

 with the following requirements:

 

■

 

10BASE-T Ethernet card (Ethernet connectivity built in with all Power Macintoshes)

 

■

 

TCP/IP connectivity (built in with Windows 98, 95, and NT and Macintosh OS 7.6 or later)

 

■

 

386, 486, or Pentium processor (PCs only) 

 

■

 

CD-ROM drive

 

■

 

A Web Browser,

 

 such as Netscape Navigator (3.0 or later) or Microsoft Internet Explorer (3.0 or later), that is 
frames-capable and JavaScript-enabled.

 

If you do not have a browser, a custom browser is provided on the 

 

OfficeConnect ISDN LAN Modem Companion Programs

 

 CD-ROM. 

Networking computers
for the first time?

Check TCP/IP defaults, page 6.
Then, proceed to "Before You Begin"

See "Checking for Dynamic vs. Static
IP Addressing," page 7

Using dynamic IP addressing
on your LAN?

YES

YES

 NOT SURE

NO

NO

See User Guide (on CD-ROM)
for installation and configuration
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To install the ISDN LAN Modem:

 

1

 

Turn off your computer.

 

CAUTION:

 

 

 

Do not connect more than one
computer for this initial setup. After installation
and configuration, you can connect additional
computers and/or printers to the ISDN LAN Modem.
Do not connect the ISDN LAN Modem to an
existing LAN until after you have completed
the configuration.

 

CONNECT YOUR COMPUTER:

2

 

Insert either end of the Ethernet cable into
one of the LAN Modem ports marked 

 

LAN

 

.

 

3

 

Insert the other end of the Ethernet cable
into your computer’s 10BASE-T Ethernet port.

 

CONNECT THE ISDN LINE:

4

 

Insert the RJ-45 (8-pin) end of the ISDN cable
into the LAN Modem port marked 

 

ISDN

 

.

 

5

 

Insert the RJ-11 (6-pin) end of the ISDN cable
into your ISDN wall jack.

 

(Optional) CONNECT ANALOG EQUIPMENT:

6

 

Connect up to two analog devices to the ports
marked 

 

PHONE,

 

 using RJ-11 to RJ-11 cables
provided with your analog equipment, as shown.

 

CONNECT THE POWER SUPPLY:

7

 

Connect the power supply to the ISDN LAN Modem.

 

8

 

Plug the wall end of the power supply into your
wall outlet (use of a surge-protected outlet strip
is recommended).

 

Watch for the following front panel LED signals:

 

■

 

PWR LED illuminates.

 

■

 

Indicator LEDs flash momentarily as the unit
undergoes a power-up self-test diagnostic.

 

■

 

ISDN LED begins to flash after a short delay.

 

9

 

Turn on your computer.

 

Watch for the LAN Status LED on the unit
to flash and then remain lit.

 

This completes the installation. Continue with “Configuring the ISDN LAN Modem.” After you have finished the 
configuration, you can connect additional computers and/or printers. If you wish to add more than four users, see 
“Connecting More Than Four Users” after completing the configuration. Refer to “Troubleshooting,” page 8, if the 
installation was not successful.
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These instructions cover the typical configuration — setting up a connection for shared access to the Internet. To set up 
a connection to a private network, such as a corporate LAN, refer to the “Additional Service Providers” section in 
Chapter 6 of the 

 

OfficeConnect ISDN LAN Modem User Guide, 

 

located on the 

 

OfficeConnect ISDN LAN Modem 
Companion Programs 

 

CD-ROM.

 

Before You Start the Configuration

 

Before you start to configure the ISDN LAN Modem, have the following ready:

 

■

 

Telephone number(s) for your ISDN line (provided by your telephone company).

 

■

 

The following information from your Internet Service Provider (ISP):

 

■

 

ISP telephone number

 

■

 

ISP account user ID

 

■

 

ISP account password

 

■

 

ISP DNS server address (if required)

 

Configuration Steps

 

To configure the ISDN LAN Modem for Internet access:

 

1

 

Launch your Web browser to start the configuration process.

A welcome message appears. (If the welcome message does not appear, refer to “Troubleshooting,” page 8.)

 

Windows 98 and 95 users:  If the Dial-Up Connection window appears, refer to “Note for Windows Dial-Up 
Networking Users,” page 7. 

 

2

 

Click 

 

Continue.

 

The ISDN LAN Modem clock is synchronized to the date and time on your workstation. The Set Password 
window appears.

 

3

 

(Optional) Enter a password in the Password field and in the Password (repeat) field to confirm. (Be sure to 
record your password for future use.) This password protects access to the LAN Modem.

 

4

 

Click 

 

Submit

 

.

The SPID Wizard window appears.

 

5

 

Enter the first telephone number for your ISDN line. 

 

6 If you have a second telephone number associated with your ISDN line, enter it in the second telephone number 
field. Otherwise, leave blank.

7 Click Continue.

The SPID Wizard begins to configure the SPIDs for your ISDN line.  Once this process is finished, the ISDN LED 
lights up, indicating that your line is ready for use.

8 Click Continue to bring up the ISP Wizard.

The ISP Wizard window appears.

9 Enter your ISP information. Choose any name for the ISP Name. If you are not sure about the DNS server 
address, leave this field blank.

10 Specify how you want the bandwidth allocated for this connection.

You can choose always to use just one B channel, always to use two B channels (that is, always use Multilink 
PPP), or you can specify that you only want the second B channel added when the first B channel reaches a 
predetermined usage rate (60% by default).

11 Specify the B channel rate.

Leave the B channel rate set to 64 Kbps, unless you know that your telephone company and the locations to 
which you will be connecting only support 56 Kbps.

12 Click Continue.

A call is launched to your ISP, and a message confirming proper configuration appears.

If you experience problems connecting to your ISP, refer to the troubleshooting section of the OfficeConnect 
ISDN LAN Modem User Guide, located on your CD-ROM.

13 Click Continue. 

This takes you directly to the support page for the LAN Modem on 3Com’s World Wide Web site. 
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STACKING OFFICECONNECT UNITS

CONFIGURING THE ISDN LAN MODEM (CONT.)

CONNECTING MORE THAN FOUR USERS

14 Click Register to register your product. 

Your parameters for connecting to your ISP have been set to a typical default through this configuration. To 
change these default parameters, enter http://3com.oc.lanmodem  or http://192.168.1.1 to reach the LAN 
Modem’s main configuration page. Click the Service Providers icon, and then select your ISP Name from the list.

This completes the configuration process. You may now connect additional computers and/or printers to your new LAN. 
If you wish to add more than four users, see “Connecting More Than Four Users.” If you wish to set up a connection to 
a private network or to a second ISP, refer to Chapter 6 of the User Guide.

For access to documentation, firmware upgrades, and all the latest information about your ISDN LAN Modem, 
go to http://www.remoteaccess.3com.com/support/docs/lanmodem/welcome.html.

The Rubber Feet. For desktop use, the four self-adhesive rubber feet prevent your ISDN LAN Modem from sliding. 
Attach the feet to the underside of the ISDN LAN Modem in the marked corners.

The Stacking Clip. The stacking clip allows you to stack two or more OfficeConnect units together securely. 

CAUTION: You can stack up to a maximum of four units. Smaller units
must be stacked on top of larger units.

To stack two units:

1 Place the first unit on a flat surface.
2 Fit the clip across the top of the unit, as shown. The longer end of the

fastening pieces should point downward.
3 Align the fastening pieces over the slots on each side of the unit, and then

push the clip down gently to secure it. Ensure that the fastening pieces
snap into the slots.

4 Rest the second unit on top of the clip and align it with the front of
the bottom unit. 

5 Press down gently to secure the top unit onto the clip, ensuring that
the fastening pieces fit into the slots, as shown.

To unstack units, gently pry the top unit away from the clip, and then carefully pull
either fastening piece out of its slot to detach the clip from the bottom unit.

5

2

Fastening
piece

Fastening
piece

Cable
holder

After you have finished configuring your ISDN LAN Modem, you can connect an additional Ethernet hub or hubs to the 
ISDN LAN Modem to add up to 25 users. An example of a ten-user connection is shown.

To connect an additional hub:

1 Insert one end of a 10BASE-T Ethernet cable
into one of the ports marked LAN on the back of
the ISDN LAN Modem.

2 Insert the opposite end of the cable into one of
the 10BASE-T Ethernet ports on the Ethernet hub.
(If you are connecting to an OfficeConnect
Ethernet Hub 8, insert the cable into port 8.)

3 If connecting to an OfficeConnect Ethernet Hub 8,
set the MDI/MDIX switch to MDI (that is, pressed in). 

If the hub to which you are connecting does not 
have an MDI/X switch, you will need a cross-over
Ethernet cable.
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6CHECKING TCP/IP DEFAULTS
It is recommended that you return your TCP/IP settings to their factory default values (this is for use with dynamic IP 
addressing). To do this, follow the steps for your operating system:

Windows 98 and 95

1 From the Start menu, select Settings, and then 
Control Panel. Double-click the Network icon.

2 Select TCP/IP, and then click Properties. If you do 
not see TCP/IP listed, refer to “Setting Up TCP/IP” 
below.

If you have more than one TCP/IP entry, select the 
entry associated with your Ethernet card.

3 Click the IP Address tab. Select Obtain an IP 
address automatically.

4 Click the Gateway tab. Click Remove to clear the 
Installed gateways field.

5 Click the DNS Configuration tab. Select Disable 
DNS.

6 Click OK to close the TCP/IP Properties window, 
and then click OK to close the Network window, 
saving any changes.

If prompted, restart your workstation.

Windows NT 4.0

1 From the Start menu, select Settings, and then 
Control Panel. Double-click the Network icon.

2 Click the Protocols tab. Select TCP/IP, and then 
click Properties. If you do not see TCP/IP listed, 
refer to “Setting Up TCP/IP” below.

3 Click the IP Address tab. From the Adapter field, 
select the Ethernet card associated with your ISDN 
LAN Modem. Select Obtain an IP Address 
automatically.

4 Click OK.

If prompted, restart your workstation.

Macintosh

1 From the Apple menu, select Control Panels. 
Double-click TCP/IP.

2 From the Connect Via drop-down list box, select 
Ethernet (if iMac, select Ethernet built-in).

3 From the Configure drop-down list box, select 
Using DHCP Server. All other entries should be 
either blank or set to <will be supplied by server>.

4 Select File, and then Close, saving any changes.

SETTING UP TCP/IP
If you are using Windows 98, 95, or NT and have never made remote connections on your computer, you may have to 
set up the TCP/IP protocol by adding it to your computer’s protocol list. To do this, have your Windows installation 
disks or CD-ROM ready, in case you are prompted for them, and then follow the steps for your operating system. 

Windows 98 and 95

1 From the Start menu, select Settings, and then 
Control Panel. Double-click the Network icon.

2 Click Add.

The Select Network Component Type dialog box 
opens.

3 Select Protocol, and then click Add.

The Select Network Protocol dialog box appears.

4 From the Manufacturers list box, select Microsoft, 
and then from the Network Protocols list box, 
select TCP/IP.

5 Click OK.

Windows NT 4.0

1 From the Start menu, select Settings, and then 
Control Panel. Double-click the Network icon.

The Network dialog box appears.

2 Click the Protocols tab.

3 Click Add.

The Select Network Protocol dialog box appears.

4 Select TCP/IP Protocol, and then click OK.

You are asked if your network has a DHCP server 
and if you would like to have IP addresses 
automatically configured. It is recommended that 
you click Yes, since the ISDN LAN Modem has a 
DHCP server and automatic configuration is 
preferred. If, however, you are on a static 
network, click No. 

You may now be prompted to insert your 
Windows NT 4.0 installation CD-ROM.

If you have Windows NT Remote Access Service 
(RAS) installed on your workstation, after the 
appropriate files are copied to your workstation, 
you are asked whether or not you would like 
TCP/IP installed for RAS. If you select Yes, you 
must select the adapter you want to access 
remotely and then click Close.

After the appropriate files are copied to your 
workstation, you will see TCP/IP Protocol listed in 
the Network Protocols group box.
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Your ISDN LAN Modem is optimized for use with dynamic, rather than static, IP addressing. In static IP addressing, a 
permanent IP address is manually assigned to each device on a network. In dynamic IP addressing, an IP address is 
temporarily assigned for the duration of a network “session” and then returned to a pool of addresses for reuse. By 
default, the ISDN LAN Modem assigns IP addresses dynamically to each attached computer.

For most users setting up a LAN for shared Internet access (regardless of whether you are connecting to the Internet for 
the first time or have already been dialing in through an individual connection), it is most likely that your computer or 
computers are set up for dynamic IP addressing. To verify that your computer or computers are set up for dynamic IP 
addressing, follow the steps for your platform:

Windows 98, 95 and NT 4.0

1 From the Start menu, select Settings, and then 
Control Panel. Double-click the Network icon.

2 Windows 98, 95:  Select TCP/IP for the Ethernet 
card associated with your ISDN LAN Modem.
Windows NT:  Select Protocols; and then TCP/IP.

3 Click Properties.

4 Click the IP Address tab. 

If Obtain an IP address automatically (Windows 
98, 95) or Obtain an IP address from a DHCP 
server (Windows NT 4.0) is selected, your 
computer has a dynamic IP address. 

If Specify an IP address is selected, your computer 
has a static IP address. 

5 Click Cancel to exit the TCP/IP Properties window, 
and then Cancel to exit the Network window.

Macintosh

1 From the Apple menu, select Control Panels.

2 Double-click TCP/IP. 

3 Select Ethernet from the Connect Via pop-up 
menu, if it is not already chosen. 

If the Configure pop-up menu is set to Using 
DHCP Server, your computer has a dynamic IP 
address. 

If Configure is not set to Using DHCP Server and 
you have specific values listed in any of the 
following fields: IP Address, Subnet mask, Router 
address, or Name server addr., your computer has 
a static IP address. 

4 Select File and Close to exit the TCP/IP Control 
Panel.

Where to Go from Here . . .

If you are set up for dynamic IP addressing, you are ready to continue directly with “Before You Begin,” page 2.

If you are set up for static IP addressing, refer to Chapters 3 and then 5 of the User Guide (located on the 
OfficeConnect ISDN LAN Modem Companion Programs CD-ROM) for your installation and configuration. You may 
have to perform additional steps not covered in this guide.

If you are already using Dial-Up Networking for remote connections, you may have to make the following changes to 
your Internet connection parameters: 

1 From the Start menu, select Settings, and then Control Panel. Double-click the Internet icon.

2 Click the Connection tab, and clear the check box labeled Connect to the Internet as needed. (If this option is 
not available, choose Connect to the Internet using a local area network instead.) Click OK.

This allows outgoing connections to run through your ISDN LAN Modem each time you launch your Web 
browser, bypassing the Dial-Up Connection window.

If you want to use Dial-Up Networking again — for example, to use another modem connected to your 
computer’s serial port when you are not using the ISDN LAN Modem — remember to switch back to the setting, 
Connect to the Internet as needed.

CHECKING FOR DYNAMIC VS. STATIC IP ADDRESSING

NOTE FOR WINDOWS DIAL-UP NETWORKING USERS
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The table below lists symptoms of common problems, possible causes, and possible solutions. For additional troubleshooting 
information from the User Guide, FAQs, and other technical notes, refer to:
http://www.remoteaccess.3com.com/support/docs/lanmodem/welcome.html. 

  
Symptom Possible Cause Solution

Launching your 
Web browser 
does not start the 
configuration 
process (the 
welcome 
message does not 
appear).

Incompatible IP 
address on your 
computer.

Reset the IP address on your computer, as follows:
Windows 98 and 95:  Run Winipcfg.exe.  Select the Ethernet adapter connected to the ISDN LAN Modem. 
Click Release All and then Renew All.
Windows NT 4.0: Run ipconfig /release and then ipconfig /renew. 
Macintosh:  From the Apple menu, select Control Panels and then TCP/IP. Make sure Ethernet is selected in the 
Connect via field. In the Configure field, select Using BootP Server to clear the fields, then close and save changes. 
Open the TCP/IP control panel again and select Using DHCP Server. The fields should now read <will be 
supplied by server> . Select File, then Close, and save changes when prompted.

Web browser needs 
the IP address of the 
ISDN LAN Modem.

Enter the following URL in your Web browser: http://3com.oc.lanmodem.  Alternatively, you can enter 
http://192.168.1.1.

Web browser may 
not be set to a 
default start page.

Launch your Web browser and enter a default URL, as follows:
Internet Explorer:  From the View menu, select Options. From Page, select Start Page, and then enter an address 
in the address field, such as http://www.3com.com.

Netscape:  From the Options menu, select General Preferences. From Browser Starts With, select Home Page 
Location, and then enter a URL such as http://www.3com.com. 

Web browser may be 
configured to use a 
proxy server. 

Launch your Web browser, and then set the browser to use the LAN Modem, as follows:
Internet Explorer:  From the View menu, select Internet Options, and then the Connection tab. Under the Proxy 
Server header, uncheck the box labeled Accessing the Internet using a proxy server.
Netscape:  From the Edit menu, select Preferences.  Double-click Advanced, and then click Proxies.  Check the box 
labeled Direct Connection to the Internet.

There is a 
configuration 
problem.

Reset the ISDN LAN Modem to the factory default setting. Disconnect the ISDN cable from the ISDN LAN Modem 
and then connect an analog telephone to one of the phone ports. Lift the handset and press **3266# and then 
replace the handset. Reconnect the ISDN cable, restart your computer, and then launch your Web browser.

Clicking “submit” 
during configura-
tion does not 
take you to the 
next screen.

JavaScript may not be 
enabled in your Web 
browser.

Enable JavaScript via your Web browser’s configuration options.

At installation, 
LAN LED does not 
light.

Wrong cable used to 
connect your 
computer  to the LAN 
Modem’s LAN port.

Make sure you are using the 8-pin to 8-pin cable labeled Ethernet which was provided with your ISDN LAN 
Modem. If you are using another 10BASE-T Ethernet (Category 5) cable, it must be a straight-through cable.

At installation, 
ALERT LED 
remains lit.

An internal failure. Notify your reseller or technical support that the ISDN LAN Modem has failed the self-test.

At installation, 
ALERT LED 
continues to 
flash.

Self-test failure, or 
the LAN Modem is in 
firmware download 
mode

Power cycle the ISDN LAN Modem. If the ALERT LED continues to flash, the ISDN LAN Modem has failed the self- 
test. Contact your network supplier. If the ALERT LED is not flashing, then the LAN Modem is now operating 
correctly.


